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This is the left half of the ribbon displaying 
the Adjust and Picture Styles groups on 
the Picture Tools: Format tab. 
This is the right half of the ribbon 
displaying the Arrange and Size groups 
on the Picture Tools: Format tab. 

UNDERSTANDING PICTURES 
 

Word allows you to not only insert images from 
clip art or the internet, but also to insert images 
you have created yourself. These kinds of 
images are digital images you have stored on 

your computer or on a computer you are connected 
to. They may be photographs, scans or various 
forms of digital art. 

 
 

 

Inserting a Picture 
Pictures are digital images which can be inserted into a document using the Pictures command on the 
Insert tab. 

Picture Positioning 
Pictures are positioned as either inline or floating. An inline picture is one that is embedded into the 
text itself, as shown in the second example directly below. A floating picture can be placed anywhere, 
even in front or behind the text (as in the first example directly below). Floating pictures can be 
positioned anywhere on the page and can even have text wrap around them as shown immediately 
below. 

This is an example of a 
floating picture. 

 
 
 
 
 

This is an example of 
an inline picture. 

 
 
 
 
 
 

Picture Tools – A Picture Editing Application 
After a picture is inserted it can be edited by clicking on it to select it. When a picture is selected, the 
Picture Tools: Format tab appears on the ribbon to reveal a range of editing commands and options –
in many ways you are provided with a range of tools previously only found in more sophisticated picture 
editing applications. 
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UNDERSTANDING ONLINE PICTURES 
 

If you want to insert images into your document, 
you have three options. You can choose to 
download and insert clip art (these include 
photographs, cartoons and other kinds of 

graphics), your own images which have been 
saved to your computer or online images from the 
Bing search engine. You can then edit these 
images using the Picture Tools: Format tab. 

 
 

 
What Is An Online Picture? 

You can access clip art by clicking on 
the Insert tab then clicking on Online 
Pictures in the Illustrations group. To 
search for online pictures, type your 
search term in the search box next to 
Bing Image Search and press . 
The difference between inserting an 
image via the Pictures function and 
the Online Pictures function is that 
Pictures directs you to images stored 
on your device, whereas Online 
Pictures directs you to images stored 
online. Both Pictures and Online 
Pictures can be photographic images 
or vector artwork. If you are using Online Pictures to specifically search for either vector or photographic 
images, you will not be able to specify using the Insert Pictures pane. Instead you must open Bing in a 
browser window, click on the Images tab and select the required options to specify the type of image you 
wish to search for. You can then download the image, save it and insert it into Word using the Insert 
Picture function (as it is now saved to your PC). 
If you are signed in with your Microsoft account you can link certain social media accounts such as 
Facebook and Flickr in order access photos stored in these accounts. 

 
Copy Right And Online Images 

Copyright is the legal right (automatically given to the creator of the content) to print, publish, perform or 
film the content. Images found on the internet are usually protected by some kind of copyright that means 
it is illegal to reproduce or use the image in certain contexts or quantities. Sometimes you have the ability 
to purchase copyright for an image which may allow you to use an image with a number of conditions 
such as for a fixed amount of time, or a number of times. When you search for an image using the 
Online Picture function, the search results displayed will automatically be those that are licensed under 
Creative Commons copyright. Creative Commons allows copyright owners to obtain free licenses that 
mean they can share reuse and remix their material legally. This means that most images under Creative 
Commons can be used in documents for your own personal use or even in some publications. If you 
don’t require a Creative Commons license you can click on [Show all web results] in the Insert 
Pictures pane. This displays images that have all different kinds of copyright licenses. 

 
 
 
 
 

This is where you can 
type your search term 
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For Your Reference… 
To insert a picture into a file: 

1. Click to position the insertion point where 
you want the image inserted 

2. Click on the Insert tab and click on Picture 
in the Illustrations group 

3. Locate and click on the desired picture and 
click on [Insert] 

Handy to Know… 
• You can specify the Wrap Text style to be 

applied to all inserted images by clicking on 
File > Options > Advanced and selecting a 
desired option in Insert/paste picture as 
under the heading Cut, Copy and Paste. 

INSERTING A PICTURE 
 

Pictures are digital images that can be inserted 
into a document using the Picture command on 
the Insert tab. Pictures need to be in a relevant 
file format, usually a JPG file, and they must be 

stored somewhere on your computer. In Microsoft 
Word a picture will be inserted with one of seven 
Wrap Text options, depending on the settings in 
Word Options. 

 
 

 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file 
Pictures_1.docx… 

1 Click at the start of the first 
paragraph 

This is where we’ll insert the 
picture… 

2 Click on the Insert tab, then 
click on Pictures in the 
Illustrations group to display 
the Insert Picture dialog box 

3 Navigate to the folder where 
the student files can be found 
(C:\Course Files for 
Microsoft Word 2016) 

4 Scroll to and click on Queen 
Victoria_1.jpg and click on 
[Insert] to insert the picture 
into the document at the 
insertion point 
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For Your Reference… 
To insert an online picture into a file: 

1. Click to position the insertion point 
2. Click on the Insert tab, then click on Online 

Pictures in the Illustrations group 
3. Locate and click on the desired picture and 

click on [Insert] 

Handy to Know… 
• If you sign into OneDrive, your account will 

appear as an online pictures option in the 
Insert Pictures pane. 

•  You can use the same procedure to insert 
an online video. Simply click on the Insert 
tab and click on Online Video in the Media 
group, then follow the same steps. 

INSERTING AN ONLINE PICTURE 
 

As well as being able to insert pictures from your 
local computer, Word also lets you insert pictures 
from various online services without having to 
save them to your computer first. The online 

options for inserting pictures include the Office.com 
clip art collection, via a Bing search, or from your 
own OneDrive or Flickr account. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Pictures_2.docx... 

1 Press  +  to 
move to the end of the 
document 

This is where we’ll insert 
the picture… 

2 Click on the Insert tab, 
then click on Online 
Pictures in the 
Illustrations group to 
display the Insert 
Pictures pane 

3 Click in the Bing Image 
Search box, type 
Queen Victoria and 
press  

The Bing search will 
return thousands of 
images of Queen 
Victoria, plus a reminder 
that images may be 
protected by copyright… 

4 Click on an image, then 
click on [Insert] to 
download the image and 
insert it at the end of the 
document 

If the image is large it 
may be inserted on a 
new page 
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For Your Reference… 
To select clip art: 

• Click on the clip art image 

To deselect clip art: 
• Click outside the clip art image 

Handy to Know… 
To move from one clip art image to another 
in a document, click on any clip art image 
then press . Each time you press 
Word will select the next image in the 
document. This is a useful way to move 
between images in a long document. 

SELECTING PICTURES 
 

Before you can modify, move, resize or format 
clip art, you need to select it and be able to 
recognise when it is selected. The key to 
identifying when clip art is selected is the 

presence of the resizing handles at each corner, 
the rotation handle above and the Layout Options 
button at the top right of the image. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the 
file Pictures_3.docx... 

1 Click on the online 
image to select it so the 
resizing handles appear 
in the top of each 
corner and halfway 
along each edge, the 
rotation handle appears 
above, and the Layout 
Options button 
appears at the top right 
of the image 

Notice if you point to 
the image, your pointer 
changes to the four-
arrow cursor indicating 
the image is selected 
and you can move it… 

2 Click outside the image 
to deselect it 

3 Click on the image 
again to select it 

Notice when the image 
is selected, the Picture 
Tools: Format tab also 
appears on the ribbon. 
This contains the 
necessary commands 
and options for editing 
images 

 
 
 
 

 
 

Rotation handle 
 

Layout Options button 
 
 
 

Resizing handle 
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Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the 
file Pictures_4.docx... 

1 Select the second 
picture if it’s not 
already selected 

Let’s see how the 
image looks on the 
right side of the 
page… 

2 Drag the image to the 
end of the first line of 
the last paragraph, 
then release the 
mouse button to 
position it as shown 

Now for more precise 
positioning… 

3 
Click away from the 
image to deselect it 
and view the result 

4 
 
Scroll up to the first 
image and click on it 
to select it 

5 Drag the image to 
position it as shown 

 

 

For Your Reference… 
To move clip art: 

1. Click on the picture to select it 
2. Drag the image to its new position, then 

release the mouse button 
3. Use the arrow keys for precise positioning 

Handy to Know… 
• Word has nine preset positions you can 

use to place images at specific points on the 
page. To apply one, select the image, click 
on the Picture Tools: Format tab, click on 
Position in the Arrange group and select a 
preset position option. These positions 
override any manual positioning. 

POSITIONING PICTURES 
 

When inserting pictures, you usually need to 
position it where desired and there are several 
ways to do this. For many text wrapping styles 
you can click on the image and drag it to its new 

position, or use the , ,  and  keys for 
more precise positioning. When moving the image, 
Word may wrap text around it, depending on what 
text wrapping style is applied. 
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Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Pictures_5.docx... 

1 Ensure the first picture is 
selected 

Let’s apply a text wrapping 
style… 

2 Click on the Picture Tools: 
Format tab, then click on 
Wrap Text in the Arrange 
group to display a menu of 
options 
Notice In Line with Text is 
selected here as this is our 
default… 

3 Point to each style to view 
a Live Preview before 
clicking on In Front of Text 
to apply text wrapping 

4 Click outside the image to 
deselect it and view the 
result 

Let’s apply a different text 
wrapping style… 

5 Repeat steps 1 to 3 to 
apply Square text wrapping 

6 Use the arrow keys to align 
the image with the text 

7 Repeat the above steps to 
apply square text wrapping 
to the second picture and 
position it as shown 

 

 

For Your Reference… 
To apply text wrapping to clip art: 

1. Select the clip art image 
2. Click on the Picture Tools: Format 
3. Click on Wrap text in the Arrange group 
4. Select a text wrapping option 

Handy to Know… 
• To quickly apply a text wrapping style to an 

image, click on the Layout Options button 
that appears to the top right of an image 
when it is selected. This will display a menu 
of options from which you can select the text 
wrapping option that best suits your 
purposes. 

APPLYING TEXT WRAPPING STYLES 
 

When you insert an image into a document, the 
image is automatically inserted with the text 
wrapping style In Line with Text applied. This 
means the image behaves like any textual 

character and therefore will sit on the same line as 
the text. To improve the layout of your document, 
you can apply one of many text wrapping styles, 
depending on how you want the image to behave. 
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For Your Reference… 
To resize a picture: 

1. Select the picture, then click on the Picture 
Tools: Format tab 

2. Adjust the Height or Width in the Size 
group, or 
Drag a corner handle 

Handy to Know… 
• You can use the Layout dialog box to alter 

not only the size of a picture, but also its 
scale. This means you can resize a picture to 
a specific percentage of the original size. To 
open this dialog box, click on the dialog box 
launcher in the Size group on the Picture 
Tools: Format tab. 

RESIZING A PICTURE 
 

Often the picture you want to include in a 
document is not exactly the size you need it to 
be. You have several options for resizing a 
picture. You can resize an image approximately 

using the mouse, or accurately using either the 
Size commands on the ribbon or the options in the 
settings. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file 

with this exercise, or open the 
file Pictures_6.docx... 

1 Click on the image on page 1 to 
select it 

2 Point to the bottom left handle 
until the pointer changes to a 
double-headed arrow, then drag 
to the left to increase the size of 
the image proportionately 

Notice how as you increase the 
size of the image the text 
automatically reflows. 

If you had dragged one of the 
middle handles rather than a 
corner handle, you would have 
stretched the image thereby 
distorting it. Let’s resize the 
image accurately now… 

3 Click on the Picture Tools: 
Format tab, click on the value in 
Width in the Size group to 
select the value, type 5, then 
press  

The Height value will adjust 
automatically to 6.8 cm as Word 
resizes images proportionately 

4 Reposition the image if 
necessary 

5 Repeat the above steps to make 
the second image smaller 
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For Your Reference… 
To apply a picture style: 

1. Click on the picture to select it 
2. Click on the Picture Tools: Format tab, then 

click on the More arrow in the Picture 
Styles group 

3. Click on a style to apply it 

Handy to Know… 
• To access Picture Styles quickly and easily, 

simply right-click on the image you wish to 
apply a style to and click on Style in the mini 
toolbar that appears, to display the Picture 
Styles gallery. 

APPLYING PICTURE STYLES TO PICTURES 
 

You can improve your pictures by applying 
picture styles, such as ‘bevelled oval border’ and 
‘shadow’. This might be particularly useful if you 
want to maintain a consistent look and feel 

across your document. The Picture Styles gallery 
offers a range of preset options, and with the 
benefit of Live Preview, you are able to test drive 
the styles before selecting one to apply. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the 
file Pictures_7.docx... 

1 Ensure the second 
picture is selected 

2 Click on the Picture 
Tools: Format tab to 
display the Picture 
Styles gallery in the 
Picture Styles group 
Some of the available 
styles are visible on 
the ribbon... 

3 Click on the More 
arrow for Picture 
Styles to display the 
entire gallery 

4 Point to the first style 
in the gallery to see it 
applied temporarily to 
the image in Live 
Preview 
Notice the size of the 
frame slightly 
increases the size of 
the clip art image... 

5 Point to the other 
styles to preview them 

6 Click on Drop Shadow 
Rectangle (first row) 
to apply it to the image 
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Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the 
file Pictures_8.docx... 

1 Ensure the second 
picture is selected 

There are two reset 
options available. Let’s 
apply the first option to 
view the result… 

2 Click on the Picture 
Tools: Format tab, 
then click on the drop 
arrow for Reset Picture 
in the Adjust group to 
display a menu of 
options 

3 Select Reset Picture 
The previously-applied 
picture style will be 
removed. Now to 
restore the image to its 
original size... 

4 Repeat step 2 to select 
Reset Picture & Size 
The image will be 
restored to its original 
size 

 

 

For Your Reference… 
To reset clip art: 

1. Click on the picture to select it 
2. Click on the Picture Tools: Format tab, then 

click on the drop arrow for Reset Picture in 
the Adjust group 

3. Select Reset Picture or Reset Picture & 
Size 

Handy to Know… 
• Reset Picture will remove any applied 

brightness, contrast or recolour settings, 
(which are located in the Format task pane 
or the Picture Tools: Format tab). 

• Reset Picture will not reset any wrap text, 
positioning or alignment options you have 
applied. 

RESETTING PICTURES 
 

You may apply a picture style to a clip art image 
only to decide you wish to revert the image to its 
original, unformatted state. This may be for many 
reasons, for instance you may decide the 

formatting you have applied doesn’t suit the rest of 
the document. Fortunately, Word gives you the 
option of removing styles and/or resizing from your 
images. 
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For Your Reference… 
To change a picture: 

1. Select the picture then click on the Picture 
Tools: Format tab 

2. Click on Change Picture in the Adjust 
group 

3. Locate the desired replacement picture and 
click on [Insert] 

Handy to Know… 
• You can use a Clip Art image or an image 

sourced from Bing to replace a picture. 
Images sourced from these sites still retain 
the formatting of the original image, saving 
you much time and effort. 

CHANGING THE PICTURE 
 

A lot of work often goes into inserting a picture 
and getting it in the right location with text 
wrapping and resizing. But what if you have to 
remove the picture, or perhaps replace it with 

another? Luckily you can swap pictures using the 
Change Picture command on the Picture Tools: 
Format tab and all the changes you have made will 
be applied to the new picture. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the 
file Pictures_9.docx... 

1 Click on the picture on 
page 1 to select it 

2 Click on the Picture 
Tools: Format tab, 
then click on Change 
Picture in the Adjust 
group to display the 
Insert Pictures pane 

3 Click on [Browse] next 
to From a file to open 
the Insert Picture 
dialog box 

4 If necessary, navigate 
to the Course Files for 
Microsoft Word 2016 
folder, then click on 
Queen Victoria 2.jpg 
and click on [Insert] to 
replace the previous 
picture with this one 

5 Reposition the picture 
until it is aligned to the 
top of the paragraph 
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For Your Reference… 
To crop a picture: 

1. Click on the picture to select it 
2. Click on the Picture Tools: Format tab then 

click on the top half of Crop in the Size 
group 

3. Drag the crop handles to adjust the image 
4. Click outside the image to apply crop 

Handy to Know… 
• To quickly crop an image, right-click on the 

image to display a mini toolbar then click on 
the crop icon to apply crop handles to your 
image. You can then crop your image as 
usual. 

CROPPING A PICTURE 
 

Cropping can be likened to cutting part of a photo 
out with scissors. Many of us have performed this 
action before, perhaps so that a photo will fit 
better in a frame. The best thing about cropping 

in Word is that, unlike when cutting out an area with 
scissors, Word doesn’t automatically delete areas 
you have cropped out. So if you change your mind 
you can easily restore these parts of an image. 

 
 

 

Notice the cropped out parts of the image appear greyed out as 
they have not been permanently deleted. 

 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file Pictures_10.docx... 

1 Scroll down to page 2 and click 
on the picture to select it 

2 Click on the Picture Tools: 
Format tab, then click on the 
top half of Crop in the Size 
group 
Notice crop handles have 
appeared at the corners and 
halfway along each side of the 
image. Let’s crop the image so 
we only see the crown… 

3 Point to the bottom corner 
handle until your cursor 
changes to a crop handle, then 
click and drag upwards and 
release, as shown 

4 Click on the upper half of Crop 
or press  to apply the crop 

Oops! We liked the image 
better when we could see the 
rest of the motif… 

5 Ensure the image is selected, 
then Click on the top half of 
Crop to redisplay the rest of 
the image 

6 Pull down the bottom handle 
until the bottom half of the 
image is visible again then 
press  to apply the crop 
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For Your Reference… 
To delete clip art: 

Click on the picture to select it 
Press 

Handy to Know… 
If the clip art image is positioned in line with 
text, it can be deleted like any other 
character – that is, using either or . 
The only difference is that unlike text, you 
must press or twice – once will select 
the image then the second press will delete 
it. 

DELETING PICTURES 
 

If you have inserted a picture that you no longer 
want, you can simply delete it. If the picture has 
text wrapped around it, the text will readjust to 
the new space that becomes available on the 

page. Deleting a picture does not remove it from 
the art gallery from which it was originally inserted. 

 
 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 

Continue using the 
previous file with this 
exercise, or open the file 
Pictures_11.docx... 

1 Ensure the second 
picture is selected 

2 Press  

The image will be 
removed from the 
document. 

Oops! We didn’t mean to 
do that. Let’s restore the 
image… 

3 Press  +  to 
restore the image 

You can also use the 
Undo tool on the Quick 
Access toolbar if you 
change your mind 
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